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Smart Insert
The Smart Insert function enables you to use GrabCAD Print Pro to plan one or more pauses 
during your print job at specific slices or heights in advance. During these pauses, you can 
open the printer door and embed electronic sensors, electronic components, mechanical parts, 
etc. When you resume printing, the printed part continues to be printed.

In your CAD software, you create a Smart Insert assembly comprising at least 2 parts:

1. a model to be printed with a cavity for an inserted object

2. an object that is inserted into the cavity

Figure 1: Assembly with a smart insert

Figure 2: Cut view of the assembly
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Design Considerations - Smart Insert
This section provides recommendations and tips for designing a model with an inserted object.

• When designing the cavity, include a 100-micron offset between the printed part and the 
object to be inserted. A snug transition is desired (see Figure 3).

Figure 3: Cavity tolerance ±100 micron

• To ensure that the printer pauses at the correct height, you need to measure the height 
from the base of the model to the top of the part. You can do this using the measuring tools 
in your CAD software (or using a caliper).

The height of the inserted object should not exceed the height of the printed model. When 
printing is resumed, the next layer requires a level surface at the next slice.

• When measuring the height, verify that the part is in its proper print orientation.

• If a model has multiple stops or the tray has multiple models with different stops, define all 
the stops of all the models in the Planned Stops section.

Figure 4: Assembly with a planned stop

For example, for an assembly with 3 objects:

1. First planned stop

2. Second planned stop

3. Printed part with inserted parts

4. 3 inserted objects
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Figure 5: Assembly with 3 objects inserted (cut view)

Table 1: Multiple Smart Inserts and planned stops (cut views)

# Multiple Smart Inserts (cut view) Description

 1
Paused at the first planned 
stop (Printed in a Glossy 
finish)

 2 Placing an object

 3

Objects inserted 

(Make sure the heights of the 
objects do not exceed the 
level of the printed parts.)

 4
Print resumed (until it is 
paused at second planned 
stop)

 5

Object inserted

(Make sure the height of the 
object does not exceed the 
level of the printed part.)

 6
Print resumed (until it is 
completed with smart inserts)

3 4

1

2
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Printing Workflow - Smart Insert
Prepare for printing in GrabCAD Print Pro.

1. Create a design in your CAD as a single assembly with a printed part and an object to 
insert.

2. Load the assembly from the File menu, and select Add as Assembly.

The STLs that you designed as an assembly are imported.

Figure 6: Loading parts as an assembly

3. In the Model Settings panel, assign Air as the material for the cavity part (object).

This ensures that support material is not printed in the cavity.

Figure 7: Assigning Air as the material of the air void

Printing in a Glossy finish also ensures no support material is printed.
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4. Measure the distance from the bottom of the model to the top of the object insert 
(GrabCAD Print™ calculates the height for the carpet or pedestal). 

Repeat this measurement for each air void enclosure.

Figure 8: Measuring height using the Scale screen

5. Enter the measurement as a Planned Stop at the top of the cavity, as measured from the 
bottom of the model.

Figure 9: Defining a planned stop for a Smart Insert

You can use the GrabCAD Print, Scale screen to measure the Z coordinate.

If a model has multiple stops or the tray has multiple models with different stops, 
define all the stops of all the models in the Planned Stops section.



Printing Workflow - Smart Insert GrabCAD Print Pro for J3/J5 Series Best Practice Guide

Page 10© Copyright 2024 Stratasys. All rights reserved.

6. Send the job to print. 

7. When the job pauses, open the printer door, and insert the relevant object.

The account holder receives an email notification that the print has paused.

8. Measure and record the total height (in mm) from the tray to the top of the inserted object.

9. Close the printer door.

10. In the Tray Height Adjustment wizard that appears, select the option that applies:

• If Planned Stop height is the same as the actual height, select Continue printing from 
the planned stop and continue with step 12.

Figure 10: Tray Height Adjustment wizard—Continue

• If Planned Stop is not the same as the actual height, select Semi-automatic tray height 
adjustment and continue with step 11.

Figure 11: Tray Height Adjustment wizard—Semi-automatic

11. Enter and confirm the Object Height (total height from the tray to the top of the object):

Verify that the measurement from the CAD software and the actual height are the 
same.
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Figure 12: Enter the object height

a. In the Object Height box, enter the recorded total height in mm (from the tray to the top 
object) and tap Enter.

b. In the Confirm Object Height box, confirm the height, tap Enter, and tap Next .

The tray adjustment is in progress. If there is an problem, you have the option to tap 

Stop .

Figure 13: Tray adjustment in progress

c. Verify that the objects/models are secured. and select All objects are mounted securely 

on the tray, and tap Next .
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Figure 14: Confirmation screen

The tray height adjustment process begins.

d. When the check mark  appears, tap Next .

e. Continue with step 12.

12. To resume printing, refer to Resuming Production After Printing has Stopped, as described 
in the User Guide.

• The Emergency Stop button appears in the printer interface. 

If there is an problem, you have the option to tap Stop .

Figure 15: Tray adjustment in progress

• The model is printed after the object is inserted.
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Figure 16: Printed smart inserts

If there are more defined Planned Stops in the job, and the job continues until the 
next pause, continue with step 7.
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Print on Object
The Print on Object function enables you to use GrabCAD Print Pro to plan a pause during 
your print job at a specific slice or height in advance. During the pause, you can open the 
printer door and secure an object in a printed jig. When you resume printing, the design is 
printed on the object.

In your CAD software, you create a Print on Object assembly with 3 parts, as follows:

1. the model design you wish to print on the surface of the object

2. the object you want to print on

3. a jig to guide the placement of an object

Figure 17: Assembly with a jig, object, and model design

Figure 18: Cut view of the assembly
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Design Considerations - Print on Object
This section describes recommendations and tips for printing a 3D design on top of an object. 

• For every object, the jig should be printed directly on the tray and has to be designed in a 
manner that prevents the object from moving during the printing process.

• When printing on an object that features an overhang, such as cantilever, an inverted cone, 
or an inverted pyramid, design a jig that entirely supports the overhanging area (see 
Figure 19 and Figure 20). 

Figure 19: Objects with overhang

Figure 20: Assembly with jig designed to support an overhanging geometry

• When designing the jig, include a ±100-micron offset between the jig and the object to be 
inserted. A snug transition is desired, (see Figure 3).

• Verify the object geometry is modeled and the part is in the proper orientation.

• To ensure that the printer pauses at the correct height, you need to measure the height 
from the base of the model to the top of the object to print on. You can do this using the 
measuring tools in your CAD software (or using a caliper).

3

1

2
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• If a model has multiple stops or the tray has multiple objects with different stops, define all 
the stops of all the objects in the Planned Stops section for each air void.

Figure 21: Assembly with a planned stop

Printing Workflow - Print on Object
Prepare for printing in GrabCAD Print Pro. 

1. Create a design in your CAD as a single assembly with the jig, the object to print on and the 
model design that you want to print on the object.

2. Load the assembly and set priorities as follows:

a. From the File menu, select Add as Assembly. 

The STLs that you designed as an assembly are imported.

Figure 22: Loading parts as an assembly
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Figure 23: Imported assembly on the tray - example

b. Right-click the assembly and set Part Priority for each of the parts as follows:

• For the jig—Priority # is 1

• For the Air void (placeholder of the object)—Priority # is 2

• For the Model design—Priority # is 3
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Figure 24: Setting Part Priority- example

3. In the Tray Settings panel, select the Print directly on tray option.

This ensures proper adhesion of the jig to the tray.

Figure 25: Print Directly on the Tray option
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4. Measure the distance from the bottom of the model to the top of the object (GrabCAD Print 
calculates the height for the carpet or pedestal). 

Figure 26: Measuring height using the Scale screen

5. Enter the measurement as a Planned Stop for the object you want to print on.

Figure 27: Defining a planned stop for Print on Object

You can use the GrabCAD Print, Scale screen to measure the Z coordinate or 
CAD.
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6. In the Model Settings panel, assign Air as the material for the object to be printed on.

This ensures that support material is not printed as part of the model.

Figure 28: Assigning Air as the material of the air void

7. Send the job to print. 

The jigs are printed on the tray.

Figure 29: Printed jigs - example

8. When the job pauses, open the printer door, place the objects within the printed jigs.

The account holder receives an email notification that the print has paused.

Figure 30: Objects placed in the printed jigs (example)

Printing in a Glossy finish also ensures no support material printed.
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9. Measure and record the total height (in mm) from the tray to the top of the object.

10. Close the printer door.

11. In the Tray Height Adjustment wizard that appears, select the option that applies:

• If Planned Stop height is the same as the actual height, select Continue printing from 
the planned stop and continue with step 13.

Figure 31: Tray Height Adjustment wizard—Continue

• If Planned Stop is not the same as the actual height, select Semi-automatic tray height 
adjustment and continue with step 12.

Figure 32: Tray Height Adjustment wizard—Semi-automatic

12. Enter and confirm the Object Height (total height from the tray to the top of the object):

Verify that the measurement from the CAD software and the actual height are the 
same.
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Figure 33: Enter the object height

a. In the Object Height box, enter the recorded total height in mm (from the tray to the top 
object) and tap Enter.

b. In the Confirm Object Height box, confirm the height, tap Enter, and tap Next .

The tray adjustment is in progress. If there is an problem, you have the option to tap 

Stop .

Figure 34: Tray adjustment in progress

c. Verify that the objects/models are secured and select All objects are mounted securely 

on the tray, and tap Next .



Printing Workflow - Print on Object GrabCAD Print Pro for J3/J5 Series Best Practice Guide

Page 23© Copyright 2024 Stratasys. All rights reserved.

Figure 35: Confirmation screen

The tray height adjustment process begins.

d. When the check mark  appears, tap Next .

e. Continue with step 13.

13. To resume printing, refer to Resuming Production After Printing has Stopped, as described 
in the User Guide.

• The Emergency Stop button appears in the printer interface. If there is an problem, you 

have the option to tap Stop .

Figure 36: Tray adjustment in progress
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• The model designs are printed on the objects.

Figure 37: Model designs printed on the objects
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Print on Tray
The Print on Tray function enables you to print a model directly on an object that functions as 
the base surface without using support material, a carpet, or a pedestal underneath the model. 
You need to adjust the build tray’s start position and its distance from the roller. This ensures 
that the print block does not collide with the object surface during printing, and that the model is 
printed accurately. 

Ensure that the object remains stable and in place while printing the model, and then set up the 
print job. 

1. Using a caliper, measure and record the total height (in mm) of the width of the object to 
print on.

Figure 38: Measuring the thickness of the object

2. Place double-sided adhesive tape on the tray and peel off the backing.

Figure 39: Placing double-sided adhesive tape on the build tray

The method of securing the object may vary. If you use double-sided adhesive 
tape, add the thickness (in mm) of the double-sided tape to the total height 
measurement.
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3. Place the object on the tray and verify that it is secured.

Figure 40: Placing the object (glass) on the tray

4. From the Wizards screen, tap Tray Height Adjustment, and then tap Next.

5. In the Tray Height Adjustment wizard, select Semi-automatic tray height adjustment.

Figure 41: Tray Height Adjustment wizard—Semi (Print on Tray)

To manually adjust the tray height, refer to the J5 Series User Guide.

6. Enter and confirm the Object Height (total height from the tray to the top of the object 
surface):

Figure 42: Enter the object height

a. In the Object Height box, enter the recorded total height in mm (from the tray to the top 
object) and tap Enter.
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b. In the Confirm Object Height box, confirm the height, tap Enter, and tap Next .

The tray adjustment is in progress. If there is an problem, you have the option to tap 

Stop .

Figure 43: Tray adjustment in progress

c. Verify that the objects is secured to the tray and select All objects are mounted securely 

on the tray, and tap Next .

Figure 44: Confirmation screen

The tray height adjustment process begins.

d. When the check mark  appears, tap Next .

7. In GrabCAD Print, add your model.
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Figure 45: Added model in GrabCAD Print

8. In the Orient tool and click Orient Face to Plane.

9. In the Orient to Plane dialog box, select Bottom. 

Figure 46: Added model in GrabCAD Print

10. In the Model Settings tool, set the finish to Glossy.

11. In the Tray Settings tool, set the Print directly on tray option.

12. Send the job to print.

13. Remove the model from the glass, if relevant.

If you want to detach the model after printing it on the glass, add a separating 
agent to the glass before you print the model. 

For example, spray a silicon spray on the glass, and then print the model.
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Print-On Tray Height Adjustment Wizard
The Tray Height Adjustment wizard enables you to set the tray height according to the 
functionality:

• For the Smart Insert and Print on Object functions, the Tray Height Adjustment wizard 
enables you to select the method for setting the tray height for the top surface of the 
inserted or print-on object, as follows:

• Planned Stop—When the Planned Stop is the same as the actual height.

Figure 47: Tray Height Adjustment wizard—Continue (Planned Stop)

• Semi-automatic tray height adjustment—When the Planned Stop is not the same as 
the actual height.

Figure 48: Tray Height Adjustment wizard—Semi-automatic

See “Smart Insert” (page 5) or “Print on Object” (page 14).

• For the Print on Tray function, the Tray Height Adjustment wizard enables you to select the 
Semi-automatic tray height adjustment method for printing a model directly on an object 
that functions as the base surface without using support material, a carpet, or a pedestal 
underneath the model. 
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• If you select the Semi-automatic tray height adjustment option, you need to enter the 
height of the object from the tray to the top surface to be printed.

Figure 49: Tray Height Adjustment wizard—Semi (Print on Tray)

Figure 50: Enter the object height

• If you select the Manual tray height adjustment option, refer to the J5 Series User 
Guide for instructions.

Figure 51: Tray Height Adjustment wizard—Manual

See “Print on Tray” (page 25).
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Air as Material
Air as Material enables you to use air as a virtual material when printing parts. The Air as 
Material feature in GrabCAD Print Pro™ is useful for controlling the part weight, textures, and 
surface finish.

When designing the voids that are filled with air, ensure that the top of the voids are sealed. To 
create a sealed air void, design the seal and the tip of the voids as follows:

• The minimum thickness of the seal is 1 mm.

• Set the tip of the void with an angle less than or equal to 7°, depending on the geometry 
(see Figure 52 and Figure 53).

Figure 52: Air voids with tips (left); Model Settings dialog - Air Void selected (right)

Figure 53: Air voids with tips (left); Air Voids with tips (right)

Important:

The degree of the angle needed to seal the tip of the void may differ for different 
printing materials. 
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Figure 54: Air Assignment in GrabCAD Print Pro - part

Figure 55: Model Setting dialog box—Air Void selected
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Figure 56: Model Setting dialog box—Cleanser and Air Digital Materials selected
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Support as Material
Use support as a model material for direct control over support placement for designing 
(textures, molding, tooling applications, etc.). Set the model to a glossy finish so that the body 
that has the support material assigned acts as a mask. For example, in Figure 57, the support 
assignment of the support material, leaves a matte-effect finish on the black part, which will be 
printed in a glossy finish. 

Figure 57: Loaded model assembly

1. Design a model assembly for implementing support as material.

2. In GrabCAD Print Pro, load the designed model assembly.

Figure 58: Loaded model assembly
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3. Disassemble the model.

Figure 59: Disassembled model into parts

4. Assign materials to the relevant parts:

a. In Model Settings, assign support material to the outer part for a textured effect.

WSS150 support material must be loaded, for this option to work.

Figure 60: Assigned support as material

b. In Model Settings, set the finish to Glossy.

c. Assign model material to the marked parts.

Figure 61: Parts that are assigned VeroBlack Plus model material

5. Reassemble the model.



Printing Workflow - Print on Object GrabCAD Print Pro for J3/J5 Series Best Practice Guide

Page 36© Copyright 2024 Stratasys. All rights reserved.

6. Set the Model Settings to a glossy finish.

Figure 62: Re-assembled model

7. Send the re-assembled model to print.
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Voxel Printing
Voxel printing enables the fabrication of many different parts with complex material distribution, 
such as a gradient or a sophisticated pattern.

In a program, such as Matlab, you slice the model and generate a stack of PNGs. Each slice 
contains the voxel information. 

After processing these files in the Stratasys Voxel Print Utility, import the generated GrabCAD 
voxel file (*.gcvf file) into GrabCAD Print Pro for printing.

This section provides instructions for voxel printing with GrabCAD Print Pro on Stratasys J3 
and J5 series 3D printers.

Slice Preparation Guidelines
When preparing the slices (PNGs files), consider the following guidelines:

• The number of slices for each material must be identical. 

• Make sure that you prepared one PNG for each slice. If a certain material is not used in a 
specific slice, create an empty PNG file (blank) for it.

• It is recommended that the layer thickness of the slices you prepare match the printer layer 
thickness. The printer layer thickness is 0.01875 mm

When printing the slices, if the slice thickness does not match the printer layer thickness, 
the printer compensates for the difference. This may include repeating or skipping slices. 

• When assigning colors to your model, it is recommended that you use the RGB values of 
the PolyJet base materials. The RGB values of PolyJet base materials are shown in the 
following table:

Important:

Verify that the computer workstation you use to send the information to the printer 
has the minimum requirements. For detailed information, refer to the relevant Site 
Preparation Guide available on the Customer Support site, 
https://www.support.stratasys.com/en.

Color Red Blue Green

Cyan 0 89 158

Magenta 161 35 99

Yellow 213 178 0

Black 30 30 30

White 220 222 216

https://support.stratasys.com/en


Generating a GrabCAD Voxel File from PNG Files GrabCAD Print Pro for J3/J5 Series Best Practice Guide

Page 38© Copyright 2024 Stratasys. All rights reserved.

Generating a GrabCAD Voxel File from PNG Files
After preparing the PNG file, you need to process it in the Voxel Print Utility in GrabCAD Print 
Pro. This utility generates a GrabCAD voxel file (*.gcvf file) that you import into GrabCAD Print 
Pro for printing.

1. In GrabCAD Print Pro, from the Apps menu, select Launch Voxel Print Utility.

Figure 63: Launching Voxel Print Utility

2. In the Voxel Print Utility, verify the Slicing Parameters are according to the dpi and 
thicknesses. 

Figure 64: Voxel Print Utility

Important: Slicing Parameters

• Slice resolution = 300 x 300 DPI

• Slice thickness = 0.01875 mm 
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3. From the Tools menu, select Insert PNG.

Figure 65: Inserting PNG file

4. In the Slice file prefix field, enter a prefix for the image files, such as ‘slice_’.

This prefix is assigned to all image files.

Figure 66: Slice file prefix 

5. Click Select and navigate to the folder that contains the PNG files.

Figure 67: Slice file prefix selection

The file size of a single *.gcvf file cannot exceed 2 GB.



Generating a GrabCAD Voxel File from PNG Files GrabCAD Print Pro for J3/J5 Series Best Practice Guide

Page 40© Copyright 2024 Stratasys. All rights reserved.

6. Select the folder with the PNG files.

The location of the files, the path to the GCVF file, and all relevant slice information appear 
in the screen.

Figure 68: PNG file selection

7. Click Next.

A progress bar shows the progress of the *.gcvf file generation, and when the *.gcvf file 
generation is complete, the Material Mapping screen appears.

Figure 69: PNG file creation

8. In the Material Mapping screen, ensure color accuracy of the model printed on the PolyJet 
3D printer, as follows:

a. Inspect the base colors that the Voxel Print Utility identified in the PNG files (right side).

b. Match each of the base colors with a suitable PolyJet model material (left side). 

c. In the Materials column, select each PolyJet Model material you want to use based on 
the color matching.

The file generation can take a few minutes, depending on the size of the file.
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For example, the blue color on the right side could be mapped to VeroCyan™V in the 
Materials column.

Figure 70: Matching each base color extracted from the PNG files with material

9. Click Finish.

10. When the following message appears, click OK.

Figure 71: GrabCAD Voxel files created

11. Click the link to access the file.

Figure 72: GrabCAD Voxel files created

12. Close the Voxel Printing Utility.

13. To print the voxel file, continue with “Printing a Voxel Print Job” on page 42.

Before printing, make sure that the Model materials that you assigned are loaded in 
the material cabinet.
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Printing a Voxel Print Job
To print a voxel print job:

1. In GrabCAD Print Pro, Print screen, select Add Models. 

Figure 73: Adding models

2. Navigate to the location of the *.gcvf file you generated, select it, and click Open.

Figure 74: Opening the voxel file
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GrabCAD Print Pro validates the file and loads it.

Figure 75: Model loaded

Before printing, make sure that the Model materials that you assigned are loaded in 
the material.



Printing a Voxel Print Job GrabCAD Print Pro for J3/J5 Series Best Practice Guide

Page 44© Copyright 2024 Stratasys. All rights reserved.

3. Click Print to send the file to print.

Important:

• During the *.gcvf file generation, an *.stl file of the model is created. GrabCAD 
Print Pro uses this .stl file to display the model on the tray, as shown in the above 
figure. Since it is not possible to view the colors you assigned to the model in 
GrabCAD Print Pro, it is very important that you make sure that the correct 
materials are loaded in the material cabinet.

• An exclamation mark icon  appears near the filename (shown above) if the 
*.gcvf file contains a material that is not loaded in the tray materials. If you do not 
load the required material in the printer, the printer ignores the material 
assignment in the *.gcvf file, and prints the file as an stl file using a default 
material.

• Only Matte surface finish is available, (not Glossy).

• Grid style selection is available.

• You can add copies of the model on the tray by right-clicking on the model and 
selecting Duplicate.

• The Scale and Orient options are not available. To change the size or the 
orientation of the model, you need to generate a new *.gcvf file with the desired 
size and/or orientation. 

• You can use the Arrange (tray) option. Tray arrangement is performed according 
to the orientation defined in the PNG files. 

Do not select the Optimize check box. 
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High Speed Mode
The High Speed mode enables users of J55™ Prime printers with GrabCAD Print Pro to print 
with 2 model materials and 1 support material. For more information about this printing mode, 
refer to the printer User Guide.
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